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While Google continues to upgrade their suite of 
applications even more applications are available from 
3rd parties writing apps for Chrome. Many of these 
apps have a mobile companion app which means you 
can integrate life on the go with an Android phone or 
tablet (or iPad or iPhone) with life online at your PC or 
laptop using the Chrome version of the app. We will 
explore a few of these apps and, more importantly, 
how to use the Chrome App store. In addition we'll 
discuss some of the recent changes Google has made 
to the main Google Apps universe including unified 
storage, the death of Google Reader and the move 
from Talk to Hangouts.  

We'll warm up with a look at Web Developer Tools 
during the Web SIG. 

http://www.tcpc.com
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TC/PC 
Business 
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Friendship Village 
 
Metro Sales 
 

Thank You! 

The Digital Viking 
 The Digital Viking is the official monthly publication of 
the Twin Cities PC User Group, an all-volunteer organization 
dedicated to users of IBM-compatible computers. Subscriptions 
are included in membership. We welcome articles and reviews 
from members. The Digital Viking is a copyrighted publication 
and reproduction of any material is expressly prohibited without 
permission. Exception: other User Groups may use material if 
unaltered and credited. 
 Disclaimer: All opinions are those of the authors and do 
not necessarily represent the opinions of the TC/PC, its Board of 
Directors, Officers, or newsletter staff. TC/PC does not endorse, 
rate, or otherwise officially comment on products available; 
therefore, readers are cautioned to rely on the opinions presented 
herein exclusively at their own risk. The Digital Viking, its 
contributors, and staff assume no liability for damages arising out 
of the publication or non-publication of any advertisement, 
article, or other item. All refunds in full or in partial, for advertis-
ing, membership or any other item shall be at the sole discretion 
of the Twin Cities PC User Group Board of Directors. 

 

Advertising 
Full page (7½ x 9½) $100.00 

Two-thirds page (7½ x 6) 80.00 

Half page (7½ x 4¾) 65.00 

One-third page (7½ x 3) 50.00 

Quarter page (3½ x 4¾) 40.00 

Member Bus. Card (2 x 3½) 10.00 

Multiple insertion discounts available. 

Contact Sharon Walbran at:: SQWalbran@yahoo.com 

Deadline for ad placement is the 1st of the month prior to publica-
tion. All rates are per issue and for digital or camera-ready ads. 
Typesetting and other services are extra and must be requested in 
advance of submission deadlines. 

Payment must accompany order unless other arrangements are 
made in advance. Place make checks payable to: Twin Cities PC 
User Group 

TC/PC 2011-2012 Board of Directors 
 

Meets second Thursday of each month at 7:00 PM. All members welcome to attend. 

Call Ross Held (612-386-3172) for meeting details. 

President —Jim Grotz jim.grotz@raymondjames.com 

Vice President —Curt Trout ctrout@troutreach.com 

Secretary - Sharon Walbran sqwalbran@yahoo.com 
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Newsletter Publisher Sharon Walbran 952-925-2726 SQWalbran@yahoo.com 

Web Master Jack Ungerleider jack@jacku.com  

Jeannine Sloan Ambassador for Friendship Village 

Ron Bruncati 612-377-7936 brunron@mtn.org 

Joel Hedland joelh@spacestar.net 
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Gary Grau    oxygary2389@yahoo.com 
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Last Month’s Meeting: To Cloud or Not to Cloud 
By Sharon Walbran, TC/PC, SQWalbran(at)yahoo.com 

At last month’s meeting we watched a webinar from APCUG’s Winter Virtual Conference on the 
Cloud presented by David Williams. First he explained what the Cloud is by using the diagram on 
the left below.  Then he presented a series of slides highlighting which companies offer services on 
the Cloud.  The Cloud offers storage space for files on the Internet on warehouses of network 
servers in various locations. Free storage is available from several providers listed here. David 
pointed out you could combine several of these services to meet your backup and sharing needs. 

 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
More extensive storage space is available for a price. Here is a partial list of providers and their 

prices and features. The presentation was full of good and timely information we can use.  
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What Has Your Computer Been Doing?  Free Utility Shows All 
by Ira Wilsker, iwilsker(at)sbcglobal.net 

WEBSITES: 
http://www.nirsoft.net 
 

http://www.nirsoft.net/utils/computer_activity_view.html 
 

https://www.techsupportalert.com/content/nifty-way-find-out-what-your-windows-computer-has-been-
doing.htm 
 

 
Many of us have encountered frustrations with our computers.  Sometimes it appears that 

running programs crash or otherwise cease functioning without explanation.  On older computers, 
most notoriously those running Windows XP, a cryptic "Blue Screen of Death" (BSOD) sometimes 
appears when there is a crash of some type, often displaying nonsensical error codes that require 
extensive research to decode.  Some suspicious computer users believe that others are accessing 
their computer, running unauthorized software or malware.  Other wary users may find it interesting 
seeing what other people may have done on a particular computer, and what programs they may 
have run, what documents were viewed, and when (what time) the computer was booted and shut 
down.  If a computer was infected by malware, it may often be of great interest to see what was 
being run on the computer at the time of infestation, and even identify the malware and its payload.  
This, and more, can be readily displayed by a tiny, free utility, LastActivityView. 

LastActivityView is one of dozens of small free utilities published by a feisty software engineer, 
Nir Sofer, on his website at www.nirsoft.net.  Nir personally writes all of his own software in his spare 
time, and makes it available to all for free.  Many of his utilities are given the highest ratings by a 
variety of web services and computer publications; all of his software is free of advertising and other 
pesky irritants, making it popular among his huge and loyal user base.  In his spare time, Nir 
personally maintains his website and updates his software, as well as creates new utilities.  One of 
his newest titles, LastActivityView has caught the attention of computer technicians, forensic 
experts, hobbyists, and others who really want to know what has really been running on a computer, 
and when the computer was accessed. 

Windows users may be passively aware that their computers save extensive, but often invisible 
files, about what they have run; LastActivityView has the capability to read these historical files and 
display additional information about many of the computer's activities.  On my primary computer, this 
record starts on the day it was manufactured, and documents everything that I have done since I 
first powered it on after removing it from its box. Every piece of software that I ever installed or 
uninstalled is listed, including date, time, description, filenames, path on the hard drive, and other 
information.  Every boot, shutdown, crash, and other event was also duly recorded.  In addition to 
simply displaying a huge file with all of my computing activities, LastActivityView also has the power 
to provide additional information for many of the items listed.  LastActivityView also can display 
detailed information about program interactions, and conflicts that caused software and hardware 
crashes. 

The actual program file itself is tiny, only about 100k in size, and requires no installation.  It is 
totally portable, and can be run from any Windows connected device.  The LastActivityView 
program, an exe file, is one of only three components included in the 64k ZIP (compressed) file 
downloaded from NirSoft; the other two items in the ZIP file are a small "readme.txt" file with simple 
instructions and other information, and a standard format Windows Help File (chm format) that can 
be opened with any version of Windows, and displays detailed help and other information.  I 
downloaded the zip file, and using Windows native utility, "unzipped" or uncompressed it into a new 
directory that I created for it.  Total space required for all three files is a miniscule 130k of drive 

http://www.nirsoft.net
http://www.nirsoft.net/utils/computer_activity_view.html
https://www.techsupportalert.com/content/nifty-way-find-out-what-your-windows-computer-has-been-doing.htm
https://www.techsupportalert.com/content/nifty-way-find-out-what-your-windows-computer-has-been-doing.htm
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space.  I also copied the files to the USB flash drive that I always have on my car keychain, so I can 
use it whenever and wherever needed. 

According to the included readme.txt file, " LastActivityView is a tool for Windows operating 
system that collects information from various sources on a running system, and displays a log of 
actions made by the user and events occurred on this computer. The activity displayed by 
LastActivityView includes: Running .exe file, Opening open/save dialog-box, Opening file/folder 
from Explorer or other software, software installation, system shutdown/start, application or system 
crash, network connection/disconnection and more... "  The file created by LastActivityView can be 
quickly exported in a variety of formats that can be utilized by a variety of other programs that can 
read csv, tab-delimited, xml, or html formatted information.  A simple copy and paste can also place 
information in other programs, such as an Excel spreadsheet.  For those who may wish to 
customize the execution of LastActivityView, several command line options are available, but most 
users will find that simply running the file without any additional commands will provide 
comprehensive and useful information. 

In addition to the obvious tracking of what was run on a computer, LastActivityView can also 
provide additional and valuable information.  I was able to prove this to myself when I examined 
some recent logs, looking for software crashes and conflicts.  One of several reasons why I do not 
use Internet Explorer as my primary browser is that for some reason, it sometimes crashes when 
open.  According to the report, my most recent software crash occurred on May 17, at 9:11:07pm 
when Internet Explorer, version 10.0.9200 crashed.  By right-clicking on the line in the log showing 
the crash, an options menu appeared which displayed what additional information could be shown.  
I first selected "Properties", which displayed the Action Time, Description (Software Crash), File 
Name, Full Path (location on hard drive), and what was most important to me, More Information.  
Similar information can be displayed as a webpage in HTML by selecting "HTML Report - Selected 
Item". The More Information line showed precisely the software conflict that caused the crash;  in 
this particular case, according to the display, there was a memory conflict between IEXPLORE.EXE 
10.0.9200.16576 and TmBpIe32.dll, which is a module or component of my TrendMicro security 
suite.  Now that I have recorded this conflict, it would be easy to determine whether this is a one-
time anomaly or a continuing problem that requires attention and remediation.  Doing a quick online 
search for TmBpIe32.dll, I found that this file is a Trend Micro Browser Plug-In for Internet Explorer 
that is designed to protect the browser from exploitation.  According to Wikipedia, "A browser 
exploit is a form of malicious code that takes advantage of a flaw or vulnerability in an operating 
system or piece of software with the intent to breach browser security to alter a user's browser 
settings without their knowledge. Malicious code may exploit ActiveX, HTML, images, Java, 
JavaScript, and other Web technologies and cause the browser to run arbitrary code."  I would not 
have been able to easily and quickly determine the cause of that particular crash without 
LastActivityView.  This is but one of countless purposes that can be accomplished with 
LastActivityView. 

LastActivityView runs on any version of Windows since Windows 2000, and includes XP, Vista, 
Windows 7 and Windows 8; both 32-bit and 64-bit systems are supported. 

For such a tiny, fast, and free program, LastActivityView is a powerful utility that can provide 
extensive information on what has been done on a Windows computer.  For anyone who would like 
to see for himself what has been running on his computer; what crashed, what caused the crash; 
files downloaded, installed, or uninstalled; and a wealth of other information, LastActivityView is a 

very worthwhile program to add to the user's arsenal of utilities.  
Go to Page 1 
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  By Jeannine Sloan 

ePub Format Library Books  

 
 Read the complete article here: http://help.overdrive.com/  
 

FTTP and FiOS  
This term means “Fiber To The Premises” and FiOS means bundled internet, telephone and 
television over FTTP. Availability is increasing but prices vary across the US.  
 

Windows 8 Keyboard Shortcut  
On the Start screen, Ctrl + Tab toggles between the “Start” screen and the “All apps” screen.  
 

Change Case in Word  
Click the Home tab to display the Font group.  

Select the text you want to change.  

Click the Change Case button. The Change Case button looks like this: Aa.  

The Change Case menu displays a list of options. Choose the item you 
want.  

 
Your text is modified to match the menu item that’s selected.  
 

Cloud Based  
Cloud-based is just fancy-talk for the fact that it runs off a web  
server somewhere rather than on your local computer.  
 

The Power of AND, OR and NOT  
The Internet is a vast computer database. As such, its contents must be searched according to the 
rules of computer database searching. Much database searching is based on the principles of 
Boolean logic. Boolean logic refers to the logical relationship among search terms, and is named 
for the British-born Irish mathematician George Boole.  
http://www.internettutorials.net/boolean.asp 

Which software will my device 
support? OverDrive Digital Edi-
tions 

OverDrive Media Console OverDrive Read 

Aluratek LIBRE Air eBook 
and Color eBook 
Amazon Kindle (1st, 2nd, 
Generations, and Keyboard) 
Barnes & Noble NOOK® 
Simple Touch™ and Simple 
Touch™ with GlowLight™ 
Google Chromebook 
iRiver Story HD 

iPhone | iPad | iPod touch 
Android 
Windows Phone 
Blackberry PlayBook 
Kindle 
Nook 
Mac 10.4.9 or newer 
Windows 

Read uses HTML5 so most 
current web browsers are 
compatible. You can read on 
your computer (Windows, 
Mac, or Linux), your phone 
(iOS v5+ or Android v2.3+), 
and your tablet (iOS v5+ or 
Android v2.3+). 

file:///C:/Users/swalbran/Documents/My%20Documents/TCPC%20News/2013.6/:%20http:/help.overdrive.com/
http://www.internettutorials.net/boolean.asp
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Windows 8 Desktop 
When first opened, the Windows 8 desktop contains only three icons: the Recycle Bin lives in the top 
corner; the taskbar’s left corner offers File Explorer (for browsing your own files) and Internet Explorer 
(for browsing the world’s offerings on the web). Everything else requires a trip to the Start screen. Until 
you follow these steps, that is: 

Right-click a blank portion of your desktop and choose Personalize. 

On the Personalization window’s left side, click the Change Desktop Icons link. 

Put a check mark in the top five boxes: Computer, User’s Files, Network, Recycle Bin, and Control 
Panel. Then click Apply. 

Remove the check mark from the option labeled Allow Themes to Change Desktop Icons. 
 
That ensures that those icons will stay put, even if you drape your desktop with a decorative theme. 
After those icons appear on your desktop, feel free to drag and drop them any place. 
http://www.dummies.com/how-to/content/add-five-helpful-icons-to-your-windows-8-desktop.html?cid=dn_article 
 

How Is the Internet Shared Between Continents? 
Intercontinental communication is NOT a cloud computing process, it is a WET one. This site explains the 
history and present use of undersea communication: http://tinyurl.com/q72t7px How the cable is made: http://
tinyurl.com/ovwlzld 
 (Note: the watermark is a map of undersea cables in the oceans in 2012.) 
 

Gas Prices 
Patrick DeHaan at GasBuddy.com says that Monday mornings are typically the cheapest time to buy 
gas, before 9 or 10 a.m. 
 

The cloud legally is? 
The cloud is loosely defined as services delivered over a network. The cloud is an excellent way to 
maximize your resources, but filled with potential third party legal pitfalls.1 

Protect yourself. Isolate your data or your company’s data by: 
•Encrypt, encrypt, encrypt! 
•Implement data-retention policies, and follow them religiously. 
•Delete redundant copies. 
•Quarantine data as much as possible. 
1In the legal realm, third party refers to: “An individual or group who does not have a direct connection 
with a legal action, but is affected by it.” Example: Internet Service Provider is innocent, hosted web site 
is involved in a legal action. This could go either way and the innocent party will likely suffer 
consequences. Read the article here: http://tinyurl.com/bwabfrl 
Summarized from Tech Republic blog 
 

Earth Engine 
Google Earth Engine brings together the world's satellite imagery — trillions of scientific measurements dating 
back almost 40 years — and makes it available online. 
Explore different views into this global timelapse built from global, annual composites of Landsat satellite images. Watch 

change across the planet's surface beginning as early as 1984. http://earthengine.google.org/#intro 

Site at Which to Waste Time 
Your daily feed where cool things happen. http://www.wherecoolthingshappen.com/ 
 

Keeping Wi-Fi Always Within Range 
With the correct tools and planning, you’ll never have to be in a wireless desert. This article at the NY 
Times summarizes the tools and costs of wireless access wherever you are. http://tinyurl.com/a3dpar7 
 
 
 

http://www.dummies.com/how-to/content/add-five-helpful-icons-to-your-windows-8-desktop.html?cid=dn_article
http://tinyurl.com/ovwlzld
http://tinyurl.com/ovwlzld
http://tinyurl.com/bwabfrl
http://earthengine.google.org/#intro
http://www.wherecoolthingshappen.com/
http://tinyurl.com/a3dpar7
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Zinio 
Access this site through Hennepin County Library to read any magazine that the library subscribes to. In 
order to explore you must log into the library using your library card number. Then click on the 
“Reference and Research” button and scroll down to “Databases A to Z”. Scroll down the resulting page 
to the Zinio link or use the keyboard shortcut Ctrl+end. Click on Zinio to create and activate a Zinio 
account. Now you are ready to browse the collection of magazines. When you click on a magazine you 
will need to log into the Zinio account again. Once you have jumped through all the hoops there is more 
reading material here than you could ever read. 
This topic was suggested by Sallie Northrup 
 

Cloud Storage vs. Local Storage 
Should I or shouldn’t I store data online? 
Your finances are already online, the banking industry made that decision. Medical records are almost all 
online now. Utilities billing and records are online. 
So you are already using the cloud, whether you wanted to or not. With what is left you can use this as a 
guideline: “A rule of thumb is that if you have information that has life and death importance, you need to 
store it physically and lock it in a vault.” http://www.onlinefilestorage.com/pros-and-cons 
 

Terms from the News 
Call them metrics, call them benchmarks, call them KPI (Key Performance Indicators), objective 
measures of performance go by many names. 
 

Unification of Devices 
Every kind of machine, from server to smartphone, can enjoy the same interface. This is the goal of a 
researcher using Ubuntu Linux. http://tinyurl.com/ctu3e52 
 

Catfish 
A catfish is a person who creates a fake online profile with the intention of deceiving someone. 

Normal.dot 
If you suspect you have a corrupt normal.dot, first close Word, then do a search on your hard drive for 
“normal.dot” (without quotes). Rename it to “abnormal.dot” (without quotes), re-launch Word and all 
should be well. 

 

7 Important Email Security Tips 
Safe online practices are important to keeping your online identity unadulterated and free from viruses, 
hackers, and all sorts of Internet-based shenanigans. And the best place to start? Your inbox. Here are 
some simple yet important security tips you should know in order to keep your email account as secure 
as possible. 

1. Use Separate Email Accounts 
2. Create a Unique Password 
3. Beware Of Phishing Scams 
4. Never Click Links in Emails 
5. Do Not Open Unsolicited Attachments 
6. Scan for Viruses & Malware 
7. Avoid Public Wi-Fi 
This article describes instances of each point and the how/why of the suggestion. Worth the read: 
http://www.makeuseof.com/tag/7-important-email-security-tips-you-should-know-about/ 
 

 

http://www.onlinefilestorage.com/pros-and-cons
http://tinyurl.com/ctu3e52
http://www.makeuseof.com/tag/7-important-email-security-tips-you-should-know-about/
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Have you disabled or removed Java from your computer? 
By John Pearce, President, Pikes Peak Computer Application Society, CO 
February 2013 issue, Bits of Bytes, http://ppcompas.apcug.org/, jlpnet (at) comcast.net 

Oracle seems to be having one security problem after another with Java. Last fall, it was 
reported that Java 7 Update 7 had problems but that Java 6 was safe (no security problems). 
Oracle released Java 7 Update 8, Update 9, and Update 10 all of which had security problems. 
The latest security problem seems to affect both Java 6 and 7. Java 7 Update 11 is available 
for download. Apparently this fixes a few problems but not all of them. The status of a patch for 
Java 6 is unknown. 

While some tech gurus (Kim Komando for one) recommend completely removing Java from 
your computer, the Department of Homeland Security is recommending disabling the Java 
plug-in in your browser(s). You can find a bunch of links by using the search term 
homeland+security+java in most any search engine. Homeland Security’s recommendation 
leaves Java available in case any desktop applications might need it. 

The current crop of malware exploits security flaws in Java that allow the download of the 
malicious payload if you simply visit an infected website. The malware download may happen 
so quickly you don’t notice it and there is no security pop-up to warn you, either. 

What to do, what to do? 
Several tech writers have suggested disabling Java in your primary browser and leaving it 

enabled it in a separate browser that is used only to access web sites that require Java. I have 
done a little checking using some of the websites in my bookmarks and found that disabling 
Java has no impact on the websites I visit most often. 

The only website I found in my bookmarks that uses Java is the speed test at http://
dslreports.com/speedtest and the site has alternatives to Java available. I didn’t have any 
problems because the websites I checked use Java script, which does not have security 

issues as Java does. I rarely use Internet Explorer but decided to disable Java in IE anyway. 

Natural Mosquito Repellent 
According to Science Daily, catnip repels mosquitoes more effectively than DEET. Grow it in your 
garden or apply undiluted catnip oil to the skin for up to two hours of protection. 
 

How Windows 8.1 Upgrades Will Get To You 
Microsoft is sharing more on how existing Windows 8 and Windows RT users will be able to 
upgrade to Windows 8.1 "Blue" preview and final. 
http://news.cnet.com/8301-10805_3-57587794-75/ 
 

The Chemistry of Fireworks 
Here is a video showing how fireworks work: http://www.bytesizescience.com/index.cfm/Fireworks 
 

Exploiting a Neglected Part of the Electromagnetic Spectrum 
Images taken with T-rays can reveal concealed objects such as weapons and bombs, and can 

distinguish different tissues in the body by their density and the amount of water they contain. 

Another big benefit is that they are non-ionizing so are harmless to humans. May replace Xrays. 

http://visions.iop.org/pdf/v22www.pdf 

Go to Page 1 

http://ppcompas.apcug.org/
http://dslreports.com/speedtest
http://dslreports.com/speedtest
http://news.cnet.com/8301-10805_3-57587794-75/
http://www.bytesizescience.com/index.cfm/Fireworks
http://visions.iop.org/pdf/v22www.pdf
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Special Interest Groups (SIGs) 
 
Most SIGs will meet at Edina Executive Plaza, Conference Room #102, 5200 
Willson Road, Edina, MN 
 Confirm with a SIG group if they meet elsewhere. 
For more info contact the SIG Leader(s) listed here. 

 w Work phone    h Home phone   c Cell phone 
 * Meets at an alternate location 

Get SIG announcements! 
Link from www.tcpc.com 

Directions to Edina Executive Plaza 
for Systems on Saturday, Access,  
Word and Picture Perfect SIGs: Take 
Highway 100 to the 50th Street/Vernon 
exit. [If you have come from the north, 
cross back over Highway 100 to the 
east side.] Take the first right and go 
past Perkins [The golf course will be on 
your left.] and continue on the east 
frontage road (Willson Road) to the 
next building—5200 . There is ample 
parking in the building’s lot. 
Conference Room #102 is on 1st floor. 

Microsoft Access 
All levels. Presentations by expert develop-
ers within the group and by MS reps. 
Third Saturday 9:00 AM—Noon 
Note: No Meetings June-August 
 
Steve Kuhlmey 952/934-8492 
 steve@kuhlmeysystems.com 
 

Microsoft Office 
Addresses the use, integration, and nuanc-
es of the Microsoft Office applications. 
Combined with Systems on Saturday 
Third Saturday of the Month  
Note: No Meetings June-August 
 
 
Steve Kuhlmey 952/934-8492 
 steve@kuhlmeysystems.com 
 

Web Page Design 
Discussion and demonstration of HTML, 
web publishing software and page design. 
 
Second Tuesday @ 6:00-7:00 PM 
Every other month 
Right before the general meeting. 
 
Jack Ungerleider 612/418-3494 c 
 jack@jacku.com 

Microsoft Word for PC & Mac 
Any level user can be proficient and efficient 
in basics and advanced features of Word.. 
Combined with Systems on  
Third Saturday 9:00 AM—Noon 
Note: No Meetings June-August 
 
Tom Ostertag 612/951-5520 w 
 651/488-9979 h 
Curt Trout 651/484-4569 h 
 ctrout@troutreach.com 
 

Systems on Saturday 
For all levels of computer challenges and any 
type of computer-related question. Incl. Q&A 
Meets 2nd & 3rd Saturdays 9:00 AM-Noon 
Note: No Meetings June-August 
 
 
Curt Trout 651/484-4569 h 
 ctrout@troutreach.com 
 

Directions to Summit Place for General Meetings: 
Proceed to Eden Prairie Center Flying Cloud Drive . [Flying Cloud Drive runs along 
the West side of the Eden Prairie Center.]  Once you have driven past Eden Prairie 
Center (on the left) along Flying Cloud Drive you will come to a stop light at Prairie 
Center Drive.  The next intersection with a stop light and left turn lane is Fountain 
Place. Turn left at Fountain Place and go straight into the parking lot. Turn left again 
to the first covered entry way of Summit Place.  There is plenty of parking in the 
large parking lot in front of the first Summit Place covered entry way.  When you 
enter the door at the first covered entry way, ask to be directed to the Performance 
Room for the TC/PC meeting.  For a map of more detailed directions and info on 
Web SIG and Board meeting, check the TC/PC website. 

Board of Directors* 
All members are welcome! Call for location. 
Selected Saturday mornings 
 
Ross Held RHeld83745@aol.com 

 
 
Community Outreach* 
To request services or volunteer to help  
Contact: 
Ross Held RHeld83745@aol.com 
 

Linux on Saturday 
This is for the Linux newbie and those trying 
to come over from Microsoft to a different 
operating system. 
Second Saturday @ 9 AM-Noon 
Note: No Meetings June-August 
 
Jack Ungerleider 612/418-3494 c 
 jack@jacku.com 
 

Picture Perfect 
Explore how to use your digital camera and 
learn how to use a variety of software for 
editing, organizing, and sharing images and 
video. 
Second Tuesday 6:00—7:00 PM 
Every other month 
Right before the general meeting 
Sharon Walbran    SQWalbran@yahoo.com 

Help yourself by helping others! 

Join the team & share your knowledge with others. 
Contact TC/PC at www.tcpc.com 

http://www.tcpc.com
http://www.tcpc.com
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Online Living with 
Google Chrome 
7:00 PM 
6:00 Web SIG 
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7:00 PM 
6:00 Pic Perf SIG 
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Reminder: No 
Saturday SIGs 
during the 
summer. See 
you in Sept. 
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SkyDrive & Office Web Apps  
By Lynn Page, Editor/Webmaster, Crystal River Users Group, FL 
March 2013 Newsletter issue, www.crug.com, lpage46 (at) tampabay.rr.com 

With a Windows Live ID you have access to Microsoft’s Office Web Apps. This lets you open, 
edit and share Word, Excel and PowerPoint documents online using SkyDrive. So you can work with 
your documents from any computer whether it has the Office applications installed on it or not. Go to 
http://skydrive.live.com in a web browser to log on or sign up for a Windows Live account.  

Store Office documents on SkyDrive to view and edit them in a browser. Or share documents 
stored on SkyDrive by linking to them in an email, blog or social network.   

Save to or Upload to SkyDrive Documents generated on your home computer can be saved to 
SkyDrive or uploaded. Use Save & Send to save an existing Word, Excel, or PowerPoint file. Select 
Save to Web, Sign in to your Windows Live Account, and then click OK. Specify a folder on 
SkyDrive, and click Save As. Type a name for the file and click Save.   

I think it is easier to create the document save it on the hard drive and then upload it to SkyDrive. 
In the SkyDrive menu bar click Upload. Then either drag and drop files from your Documents folder 
to the upload box or browse to and select them for upload. To open a document in SkyDrive, select 
the folder where document is saved, and click the file name.   

 
Create New Documents in the Web Browser  

With the Office Web Apps you can create Word, Excel or PowerPoint files right in a web browser. 
The Office application doesn’t have to be open or even installed on the computer.   

Sign into SkyDrive and click the kind of document to create in the Create drop down menu. In the 
dialog box type a name for the document and click the Create button.  

A new document opens for editing in the appropriate Web App. Simply create the document as 
you would in the Office application. The Web App will not have the full features of the Office 2010 
application but is familiar.   
Share Files on SkyDrive  

SkyDrive allows you to share your Office documents, photos and other files. You can share 
individual files or an entire folder.  In SkyDrive locate the folder or file to share and place a check in 
the selection box. Click Sharing on the Menu bar. The default method of sharing is by email. This 
lets you give specific people permission to access and even edit your files. Add the email addresses 
for those who will be reviewing the files, add a message and click the Share button. To access the 
document the recipients must have an account or create one.  

The Post to option places a link to your SkyDrive files on a social media service like Facebook. I 
wouldn’t choose this method of sharing as it is open to any of your friends or their friends if they 
repost.  

The Get a link sharing option creates a link you can send to others. The advantage is they do not 
need to have a SkyDrive account. The disadvantage is that anyone with the link can access the file. 

http://www.crug.com
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I would use the View only option for sharing a link. It allows anyone with the link to see the file. The 
View and Edit link allows anyone with the link to see and edit the shared files. If you select Public 
sharing anyone can search for and view the public files. 
 
Organize/Manage SkyDrive  

SkyDrive storage can be managed in a similar way as Documents on your hard drive. A new 
SkyDrive account will have three folders: Documents, Pictures and Public. 

Create new folders with the Create drop down menu. Folders can be nested within these three 
main folders or added on the main file location. Go to the location to add a folder, click Create and 
select Folder from the drop down menu. Enter a name for the folder and it is all set for storing files. 
The path to the files or folders is shown in the title bar. The number in the bottom right corner of a 
folder shows the number of files it contains. 

If you change your mind about how folders should be organized you can move them. To move a 
folder, go to it in SkyDrive. On the Main menu click Folder actions and select Move folder to from the 
drop down menu. In the dialog box add a new folder or select the location to move the folder.  

The Manage drop down menu is used to manage files. It allow for renaming, deleting, moving 
and copying files. The trick is that you must go the folder containing the file and place a check in the 
selection box. That opens additional commands on the Menu bar.  

To move the file place a check in the selection box (top right corner), click Manage in the Menu 
bar and select Move to in the drop down menu. In the dialog box select the location for the file to be 
moved. 
Word Web App 

 

The Home tab contains basic text and paragraph formatting including Styles.   
The Insert tab is used to insert tables, pictures, clip art and links. To insert a table inthe Insert 

Table drop down point to the number of rows and columns and click.  
Clicking the Picture icon opens Windows Explorer to select a picture to insert into the document. 

Browse to and select the picture and click Open. The picture is uploaded and inserted into the 
document.   

Clicking the Clip Art icon opens a search box. Type in a description and click the search symbol. 
Browse through the clip are pieces, select one and click the Insert button.   

Once a picture or clip art has been uploaded a Picture Tools Format tab appears when the 
graphic is selected. Tools are available to Grow or Shrink the picture and add a Picture Style.   

The Page Layout tab specifies page setup and paragraph indent and spacing. Page Setup 
options include margins, page orientation and size.  

Save the document when it is complete. Clicking Save on the File tab saves it on your SkyDrive. 
Clicking Save As allows you to download a copy and save it on your hard drive.  
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Excel Web App 

 
The Home tab has font formatting and alignment, number formatting and table formatting. The 

Cell commands allow for insertion or deletion of rows, columns, cells and new sheets. The Formulas 
group includes the commonly used functions. The Data group can refresh the workbook connections 
and recalculate or search the workbook to Find something. 

Insert Functions, Tables, Charts and Links from the Insert tab. The number of charts available is 
limited but sufficient.   

The View tab has only two options. You can use the standard Editing View or choose Reading 
View to look at the data without toolbars. 
PowerPoint Web App  

When creating a PowerPoint presentation on the web app there a very limited number of themes. 
In the first dialog box chose a theme. There are also four customize buttons that change the color 
scheme. Once the theme has been set and the Apply button clicked a new presentation opens.  

The Home tab has the Clipboard, Slides, Font, Paragraph and Drawings groups. The font and 
paragraph formatting commands are limited to the basic functions. The number of shapes is limited 
but you still have styles, fill and outline. I like the new Delete group as it provides one click option to 
delete a slide. 

 
The Insert tab has a New Slide button to open the dialog to select a slide style to add to the 

presentation. Adding pictures and clip art is same as in the Word Web App. Shapes and SmartArt 
are added in the Illustrations group. 

The Text group contains the Text Box icon. 
 

The Design tab offers the same themes and variations shown in creating the presentation. So if 
you decide that the selected theme isn’t working change it to one more suitable. Set the animation 
on the slide and timing or reorder the animations on the Animation tab. Slide transitions are limited 
to none, fade and push and are controlled on the Transitions tab. The View tab has three 
Presentation Views as well as Notes and Comments. The Editing View is the normal view you would 
use in PowerPoint with slide icons for selecting or sorting and the active slide pane. The other 

options are Reading View and Slide Show.  
Go to Page 1 
 



 
You have just read an issue of The Digital Viking. 

 
Would you like to receive this delivered directly to your email or business each month? 

 
As a member of TC/PC, the Twin Cities Personal Computer Group, one of the benefits 

 is reading this monthly publication at www.tcpc.com.. 
 

As a member of TC/PC, you may attend any or all of the monthly Special Interest Group (SIG) meetings and be eligible for 
software drawings. The small membership fee also includes  

access to real-live people with answers via our helplines, discounts, and various other perks. 
 

Does membership in this group sound like a good way to increase your computer knowledge? 
 

It’s easy to do! Simply fill in the form below and mail it to the address shown. 
(If you use the form in this issue, you will receive an extra month for joining now.) 

 

 
Here’s the info for my TC/PC Membership: 
 

Full name_____________________________________________________ 

 

Company name________________________________________________ 

 

Address______________________________________________________ 

 

City_______________________________ State_________ Zip__________ 

 

Home  Business  Change address: Perm. Temp. ‘til ___________ 

 

Home phone____________________  Work phone____________________ 

 

Online address(es) _____________________________________________ 

 

Where did you hear about TC/PC? _________________________________ 
 
 I DO NOT want any of my information disclosed. 

 I DO NOT want to receive any mailings 

 
Administrative Use Only     Rec’d_____________________  Chk#_______________ 

 6/13 
I’m signing up for: 
 

 Individual/Family Membership ($18) 

 Business Membership ($100) 

 Student [ID required] ($20) 

If an existing member your # __________ 

Make checks payable to: 

Twin Cities PC User Group 
341 County Rd C2 W 
Roseville, MN 55113 
 

http://www.tcpc.com 
 

 Check #__________  Bill me 

 New member  Renewal  Prior member 

I’m interested in: 

 Training classes  Volunteering 

 Special Interest Groups: New User, Access, 
etc. 

List here: 

June 2013 The Digital VIKING 15  



   

FIRST CLASS MAIL 341 County Rd C2 W 
Roseville, MN 55113 

November 8, 2011 • 7 PM 

General Meeting 
 

The Microsoft Store 
 

The Microsoft Store 
162 South Avenue 

Mall of America 

More info: www.tcpc.com 

P 

June 11, 2013 

General Meeting 
 

Online Living  
with Google Chrome 

 

 

Summit Place 
8505 Flying Cloud Drive  
Eden Prairie, MN 55344 

 

More info: www.tcpc.com 

Summit 
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Fountain Pl 
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Eden Prairie 
Center 
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